How to Configure and Use MRP in SAP Business One 9.0
All Countries
## Typographic Conventions

<table>
<thead>
<tr>
<th>Type Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Example</strong></td>
<td>Words or characters quoted from the screen. These include field names, screen titles, pushbuttons labels, menu names, menu paths, and menu options. Textual cross-references to other documents.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Emphasized words or expressions.</td>
</tr>
<tr>
<td><strong>EXAMPLE</strong></td>
<td>Technical names of system objects. These include report names, program names, transaction codes, table names, and key concepts of a programming language when they are surrounded by body text, for example, SELECT and INCLUDE.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Output on the screen. This includes file and directory names and their paths, messages, names of variables and parameters, source text, and names of installation, upgrade and database tools.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>Exact user entry. These are words or characters that you enter in the system exactly as they appear in the documentation.</td>
</tr>
<tr>
<td>&lt;<strong>Example</strong>&gt;</td>
<td>Variable user entry. Angle brackets indicate that you replace these words and characters with appropriate entries to make entries in the system.</td>
</tr>
<tr>
<td><strong>EXAMPLE</strong></td>
<td>Keys on the keyboard, for example, F2 or ENTER.</td>
</tr>
</tbody>
</table>
# Table of Contents

**Introduction** ..................................................................................................................................................... 4

**MRP Process in SAP Business One** .................................................................................................................. 5

**Defining Initial Settings** ...................................................................................................................................... 8
  - Defining Item Master Data Window .................................................................................................................. 8
  - Order Interval – Setup Window ....................................................................................................................... 10
  - Defining Warehouses ....................................................................................................................................... 11
  - Defining Forecasts .......................................................................................................................................... 13
  - Defining Forecast Consumption ....................................................................................................................... 17
    - Defining Forecast Consumption at Company Level ......................................................................................... 18
    - Settings at Sales Order Level ..................................................................................................................... 20
    - Settings at Sales Blanket Agreement Level ................................................................................................. 21

**Using the MRP Wizard** ...................................................................................................................................... 24
  - MRP Wizard - Introduction Screen .................................................................................................................. 24
  - Step 1 of 6 – Scenario Selection Screen .......................................................................................................... 24
  - Step 2 of 6 – Scenario Details Screen .............................................................................................................. 25
  - Example of Sort by Assembly Sequence .......................................................................................................... 29
  - Step 3 of 6 – Item Selection Screen ................................................................................................................ 29
  - Step 4 of 6 – Inventory Data Source Screen .................................................................................................. 31
  - Step 5 of 6 - Documents Data Source Screen ............................................................................................... 32
  - Step 6 of 6 – MRP Results Screen .................................................................................................................. 37
    - General Area ................................................................................................................................................... 38
    - MRP Results Screen - Report Tab – Collapsed View ..................................................................................... 38
    - Report Tab - Expanded View .......................................................................................................................... 46
    - MRP Results Screen – Recommendations Tab ............................................................................................ 53

**Creating Order Recommendations** .................................................................................................................. 57

**Printing MRP Recommendations** ................................................................................................................... 63

**Authorizations** ................................................................................................................................................... 64

**Appendix** .......................................................................................................................................................... 65
  - Example 1: Procurement Method ...................................................................................................................... 65
  - Example 2: Consumption Method .................................................................................................................... 65
  - Example 3: Tolerance Days ............................................................................................................................. 67
Introduction

Material Requirements Planning (MRP) enables you to plan material requirements for a manufacturing or procurement process. MRP calculates gross requirements for the highest Bill of Materials (BOM) level based on sales orders, production orders, forecasts, and so on. It calculates gross requirements at the lowest BOM levels by carrying down net parent demands through the BOM structure. Dependent levels may have their own requirements based on sales orders and forecasts.

The results of the MRP run are recommendations that fulfill gross requirements by taking into consideration the existing inventory levels and the sources that you define in the MRP wizard run, such as existing purchase orders, production orders, purchase blanket agreements, inventory transfer requests and so on. For each item, the MRP run also takes into account defined planning rules for Order Multiple, Order Interval, Minimum Order Quantity, Lead Time, and Tolerance Days.

Recommendations are back-scheduled by the defined lead time to arrive at the requirement dates for their own components.
SAP Business One lets you divide the MRP run into equal periods of time (for example, weeks or days). The process always starts with the parent item at the highest level and ends with the last child item.

**Procedure**
For every given time period, MRP performs the planning process in the order described below:

**Calculations for the Parent Item**

1. MRP calculates the quantity required to continue the sales of the final product without any delays, considering all the resources:
   - Initial inventory (quantity on hand)
   - Receipts:
     - Purchase orders
o Production orders (for the parent item)
o Purchase blanket agreements
o Inventory transfer requests to the warehouse
o A/P reserve invoices
o Recurring order transactions on the A/P side

Note

Inventory transfer requests are relevant for the MRP process only when the MRP wizard is run by warehouse level.

SAP Business One then subtracts the following requirements:
o Sales orders
o Forecast
o Production orders (for the child items)
o A/R reserve invoices
o Sales blanket agreements
o Recurring order transactions
o Inventory transfers from the warehouse
o Defined inventory levels

2. SAP Business One uses the planning policy to make recommendations for production or purchase orders, as well as inventory transfers. The planning policy is based on:
o Lead time
o Minimum order quantity
o Order multiples
o Order intervals
o Tolerance days

Note

The above parameters are defined in the Item Master Data window. For more information, see Defining Initial Settings.

3. SAP Business One calculates recommendations for production orders, purchase orders, or purchase requests, and when relevant, inventory transfer requests for the parent item.

4. Quantities of the child items that comprise the BOM are needed to complete the production orders for the parent item. SAP Business One calculates the quantity of the child items, considering the MRP-dependent requirements. SAP Business One then recommends the creation of purchase orders, production orders, and inventory transfers for the child items required to produce the parent item.

Note

o If at any level the procurement method of the item in question is Make, the MRP process continues to the next sublevel, calculating the recommendations for the child items, as well.
o If at any level the procurement method for the item in question is Buy, no child items need to be taken into account.
Calculations for the Child Item

1. SAP Business One calculates the quantity required to continue the sales of the final product without any delays, considering the following resources:
   - Initial inventory (on hand quantity)
   - Receipts (similar to the calculation for the parent item)
SAP Business One then subtracts the following requirements:
   - All the requirements specified above (similar to the calculation for the parent item)
   - MRP Dependent Requirement – The quantities of child items required to complete the production orders recommended by MRP for the parent item (requirements for the child items calculated during the MRP run)

2. SAP Business One uses the planning policy to make the order recommendations, similarly to the calculation for the parent item.

After the calculation is completed, SAP Business One issues recommendations for production orders, purchase orders, or inventory transfers for the child items.

Note
- The process continues in the same manner if the child item has child items of its own and ends at the lowest level of the BOM.
- Disassembly production orders appear in the demand for the parent item and in the supply for the child item.
Defining Initial Settings

To start using the MRP module, you need to make several initial definitions.

Defining Item Master Data Window

Procedure
1. From the SAP Business One Main Menu, choose Inventory → Item Master Data → Planning Data tab.

2. Specify the following information related to MRP and production:

<table>
<thead>
<tr>
<th>Field</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planning Method</td>
<td>Determine which items to include in the MRP process:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <strong>MRP</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Select this option to include the item in the MRP process.</td>
<td></td>
</tr>
</tbody>
</table>
### Field: Defining Initial Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Procurement Method</strong></td>
<td>Select the acquisition method for the MRP recommendations:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <strong>Make</strong></td>
<td>Select this option if you want MRP to generate recommendations for production orders.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Buy</strong></td>
<td>Select this option to generate MRP recommendations for purchase orders. This option is suitable mainly for the child items in the lowest level of the BOM or for items that are not part of a BOM.</td>
</tr>
<tr>
<td></td>
<td>Note</td>
<td>With both options, it is possible for the MRP wizard to generate recommendations for inventory transfers when it is run by warehouse.</td>
</tr>
<tr>
<td><strong>Order Interval</strong></td>
<td>Select one of the existing intervals in the choose from list or define a new one. To define a new order interval, select Define New.</td>
<td>The <strong>Order Interval</strong> field represents the time interval between one order and another for the MRP requirements calculations.</td>
</tr>
<tr>
<td></td>
<td>For more details, see Order Interval – Setup Window.</td>
<td>Example</td>
</tr>
<tr>
<td></td>
<td>Note</td>
<td>When running an MRP, and if due to the interval order the demand will not be satisfied, the system schedules the recommendation earlier to satisfy the demand.</td>
</tr>
<tr>
<td></td>
<td>Note</td>
<td>Order intervals are always counted from the Start Date forward. For example, if you choose Every 2 Days, the MRP takes the Start Date.</td>
</tr>
</tbody>
</table>
### Order Interval – Setup Window

Use the **Order Interval – Setup** window to define time intervals between different orders.

**Procedure**

1. From the SAP Business One **Main Menu**, choose **Inventory → Item Master Data → Planning Data** tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Order Multiple</strong></td>
<td>Set a multiplication factor for ordering the item.</td>
<td>Example: If you enter 5 in this field and 14 items are required, MRP recommends ordering 15 items (3X5=15). If 18 items are required, the recommendation is to order 20 items (4X5).</td>
</tr>
<tr>
<td><strong>Minimum Order Qty</strong></td>
<td>Specify a minimum quantity for ordering items by MRP.</td>
<td></td>
</tr>
<tr>
<td><strong>Lead Time</strong></td>
<td>Specify the number of days it takes to produce or obtain an item.</td>
<td>Example: If 3 days are required to produce a certain parent item, MRP issues a purchase or production order for the child items with a due date that is 3 days earlier than the due date of producing the parent item.</td>
</tr>
<tr>
<td><strong>Tolerance Days</strong></td>
<td>Define the number of days outside of the lead time that you are willing to tolerate before the demand for the item is satisfied. For more details, see Example 3: Tolerance Days.</td>
<td></td>
</tr>
</tbody>
</table>

**Note**

You can also define **Planning Data per Item Group** in the **Item Groups – Setup** window (**Administration → Setup → Inventory → Item Groups → General** tab).

3. Open the **General** tab in the **Item Master Data** window.

If you want to define the item as a bill of materials, which is not a production type, select the **Phantom Item** checkbox. A phantom item is similar to an assembly bill of materials; therefore, it cannot be defined as an inventory item and is not included in the MRP recommendations.

4. To save your changes, choose the **Update** button.
2. In the **Order Interval** dropdown list, to open the **Order Interval Cycles – Setup** window, choose **Define New**.

![Order Interval Setup Window](image)

3. Specify the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Activity/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cycle Code</strong></td>
<td>Enter a name for the interval.</td>
</tr>
</tbody>
</table>
| **Recurrence** | Set the frequency of issuing orders:  
  
  - **Weekly**  
    Select this option to define a weekly interval. This changes the field on the right to a dropdown list containing the days of the week. Select the required day on which you would like to issue orders.  
  
  - **Monthly**  
    Select this option to define a monthly interval. This changes the field on the right to a dropdown list containing the days in the month. Select the required day in the month on which you would like to issue orders.  
  
  - **Every X Days**  
    Select this option to define an interval according to a certain number of days. In this case, define the number of days in the field on the right. |

4. To add the **Order Interval** to the system, choose the **Add** button.

### Defining Warehouses

**Procedure**

1. From the SAP Business One **Main Menu**, choose **Administration → Setup → Inventory → Warehouses**.
2. To define a warehouse as the default in the MRP wizard, select the *Nettable* checkbox. If the checkbox is deselected, the warehouse appears in the list of warehouses in the MRP wizard but MRP does not select it automatically.

3. To save your changes, choose the *Add* button.

**Note**

Drop-ship warehouses cannot be defined as *Nettable* and, therefore, cannot be part of the MRP run.
Defining Forecasts

In many cases, production companies receive sales orders at short notice. However, the production process might take a great deal of time. As a result, it is common for these companies to plan their purchasing and production in advance, even before they receive actual sales orders. This is the goal of a forecast. A forecast is designed to serve as additional demand. Therefore, the goods are produced or purchased based on the forecast, and when the actual sale orders are received, the company is able to supply the order at short notice.

There are two ways of defining forecasts:

- **Manually** - You can enter the forecast quantities manually.
- **Automatically** - SAP Business One generates forecast quantities based on historical sales records.

For both methods, follow the procedure below.

1. Note
   
   Although there is no restriction on the number of forecasts you can define, you can select only one forecast for a single MRP scenario. For more information, see Using the MRP Wizard.

**Procedure**

1. From the SAP Business One Main Menu, choose MRP → Forecasts.
   
   The Forecasts window opens. Switch to Add mode.

2. Specify the following information related to the forecast:

<table>
<thead>
<tr>
<th>Field</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Forecast Code</strong></td>
<td>Enter a unique code for the forecast.</td>
<td></td>
</tr>
<tr>
<td><strong>Forecast Name</strong></td>
<td>Enter a relevant description for your forecast.</td>
<td></td>
</tr>
<tr>
<td><strong>Start Date</strong></td>
<td>Specify a start date for the forecast horizon.</td>
<td>Note that the date you specify depends on the value selected in the View field.</td>
</tr>
</tbody>
</table>

Example

- If you enter February 15, 2014 as the
### Defining Initial Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Date</td>
<td>Specify an end date for the forecast horizon.</td>
<td>start date and the selected view is <em>Monthly</em>, SAP Business One changes the date automatically to the beginning of the month, February 1, 2014.</td>
</tr>
</tbody>
</table>
| View      | Select the time period for managing the forecast. Click the dropdown list and select *Daily, Weekly, or Monthly*. The columns in the table change respectively according to the selected option. | - **Daily**  
  Select this option to divide the forecast into days. SAP Business One displays a column for each day in the selected date range.  
  - **Weekly**  
  Select this option to divide the forecast into weeks. SAP Business One displays the week number as the column name (52 weeks in a year).  
  - **Monthly**  
  Select this option to divide the forecast into months. SAP Business One displays the name of the month as the column name.  
  - **Note**  
  You cannot update the view after adding the forecast. |
|           |                                                                           | If you enter May 15, 2014 as the *End Date* and the selected view is *Monthly*, SAP Business One automatically moves the end date to the end of the month. |

**Note**  
The weekly numbering definition and weekend definition may affect the week numbers and the first day of the week. To maintain the settings, choose **Administration → System Initialization → Company Details → Accounting Data → Holidays**.

**Note**  
If in the *Holiday Dates* window, the *Set Weekends as Work Days* checkbox is deselected, and in the forecast you have certain amounts defined on the weekend days, the MRP wizard schedules recommendations so that the demand is met on the last working day before the weekend.

**Note**  
Regardless of the selected view, MRP considers the requirements to the first day of the period. For example, if you select a *Weekly* view, week number 23 starts on June 2, 2014 and ends on June 8, 2014, according to the *Holidays* definition of the company. Therefore, the forecast relates to June 1, 2014, which is the beginning of the given week.
3. To specify forecast items and quantities, use one of the following methods:

- **Defining Forecasts Manually**
  1. In the **Item No.** column, specify one or more items to include in the forecast. The description for an item is automatically displayed in the **Item Description** column, according to the definitions in the **Item Master Data** window.
  2. Specify the quantities for every period in the items’ sales units. You can define **Sales Units** under **Inventory** → **Item Master Data** → **Sales Data** tab → **Sales UoM**.

  **Note**

  You are not required to enter a value for every period, for example, for every week in the forecast.

- **Defining Forecasts Automatically**
  1. In the **Forecast** window, choose the **Generate** button. The **Generate Forecasts - Setup** window appears.
2. Define the selection criteria to filter items which you want to include in the forecast.

3. For further selection criteria, choose Advanced Settings.
   If you want the system to calculate quantities based on sales history, select the Base on Sales History checkbox and from the dropdown list, select one of the options:
   - Simple Average - For each of the selected items, total quantities from the sales documents (that you define in the next step) within the history start date and end date, are summed up. The summed quantities are then averaged by the number of days, weeks or months according to the forecast start and end date.
   - Daily Average - For each of the selected items, total quantities from the sales documents, for each day within the history start and end date, are extracted. The extracted quantities per day are populated into each day within the forecast start and end dates.
   - Weekly Average - For each of the selected items, total quantities from the sales documents for each week are summed up. The summed quantities per week are populated into each week within the forecast start and end dates.
   - Monthly Average - For each of the selected items, total quantities from the documents for each month are summed up. The summed quantities per month are populated into each month within the forecast start and end dates.

   Note
   Available calculation methods described above vary according to the definition of the View field in the Forecast window.

4. To define which sales documents you want to be taken into account, choose one of the following radio buttons:
   - Sales Orders
   - Deliveries and A/R Invoices

5. In the History Start Date field, enter the sales history start date. SAP Business One calculates the end date according to your definition of the forecast horizon.
   For example, the forecast horizon is from June 2, 2014 to June 8, 2014 (one week). If you enter September 16, 2013 in this field, the system defines September 22, 2013 as the end date.

6. To generate the forecast data and return to the Forecast window, choose OK.

4. After you have defined items and quantities manually or automatically, you can use the Forecast Quantity Adjustment buttons to increase or decrease the target quantities by 5%. To do so, select one or more desired item rows and choose the Scale Forecast Quantity Up button to increase the quantities or the Scale Forecast Quantity Down button to decrease them.
   You can also select the desired item rows and enter a positive or negative percentage number in the Forecast Quantity Adjustment field to increase or decrease the selected values.

   Note
   Negative quantities of items in the table are not supported.

5. To save the forecast changes, choose the Add button.

   Note
   You can display additional fields by clicking (Form Settings) in the toolbar.
Defining Forecast Consumption

You can define sales orders and sales blanket agreements to consume forecast in order to avoid the duplication of the demand. This means that the forecasted quantity of the item is reduced by the quantity committed in sales orders and sales blanket agreements. If on the other hand you choose a sales order or a sales blanket agreement not to consume forecast, the quantity of said sales order will not be subtracted from the forecasted amount, but will be treated as a separate source of demand. In other words, MRP presents forecast requirements only for quantities that have not yet been ordered; only the net forecast quantity is added to the requirements. For further clarification, see the simplified examples below.

Example 1

Data for Item A1 on 16.06.2014

Forecast, quantity 100

Sales orders consuming forecast, quantity 50

Inventory level is zero, no other supply

MRP (for Item A1 for 16.06.2014)

Recommendations for 16.06.2014, quantity 100

The quantity in sales orders consumes forecast, SAP Business One counts it as part of the forecasted quantity.

Example 2

Data for Item A2 on 16.06.2014

Forecast, quantity 100

Sales orders consuming forecast, quantity 120

Inventory level is zero, no other supply

MRP (for Item A2 for 16.06.2014)

Recommendations for 16.06.2014, quantity 120

The quantity in sales orders consumes forecast, SAP Business One counts it as part of the forecasted quantity.
Forecast consumption can be defined at the following levels:

- **Company level** - You can activate forecast consumption at the company level so that any new sales orders or sales blanket agreements consume forecast by default. For more information, see Defining Forecast Consumption at Company Level.

- **Sales order level** - You can activate or deactivate forecast consumption (depending on the settings in the General Settings window) for each line in a sales order. For more information, see Settings at Sales Order Level.

- **Blanket agreement level** - Much like with sales orders, you can activate or deactivate forecast consumption for each item in the blanket agreement. For more information, see Settings at Sales Blanket Agreement Level.

In the MRP wizard run, you can choose MRP to take a forecast into account. If you do so, MRP considers the forecast within the MRP horizon, checking whether sales orders and sales blanket agreements already exist in the system according to the consumption method specified on the General Settings Inventory tab.

For information on defining the forecast method, see Defining Forecast Consumption at Company Level.

### Defining Forecast Consumption at Company Level

1. From the SAP Business One Main Menu, choose Administration → System Initialization → General Settings → Inventory tab → Planning subtab.
2. Specify the following data:

<table>
<thead>
<tr>
<th>Field /Checkbox</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Consume Forecast</strong></td>
<td>Select this checkbox to set the value Yes as the default value in the Consume Forecast field in any new sales orders and blanket agreements.</td>
<td></td>
</tr>
</tbody>
</table>
| **Consumption Method** | To take quantities of items sold in sales orders and sales blanket agreements into account and to ensure that they are not included in planned requirements, SAP Business One searches for existing forecasts that are closest to the sales order delivery date. In the case of sales blanket agreements, it searches for existing forecasts closest to the date ranges defined in the details of the blanket agreements. Choose between two available methods of forecast consumption:  
  - **Backward-Forward**  
    First, SAP Business One searches previous periods of time up to the first day of the required range (as defined in the Days Backward field). If no forecast is found (or the forecast that is found is insufficient), SAP Business One searches ahead starting from the sales order delivery date.  
  - **Forward-Backward**  
    First, SAP Business One searches ahead starting from the sales order delivery date up to the last day of the required range (as defined in the Days Forward field). If no forecast is found (or the forecast that is found is insufficient), SAP Business One searches backwards starting from the sales order delivery date. | See Appendix: Example 2: Consumption Method. |
| **Days Backward** | Specify the maximum number of days for SAP Business One to search backwards for a forecast, to |  |
### How to Configure and Use MRP in SAP Business One 9.0

#### Defining Initial Settings

<table>
<thead>
<tr>
<th>Field /Checkbox</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Days Forward</td>
<td>Specify the maximum number of days for SAP Business One to search forward for a forecast, to take into account quantities of items sold in sales orders, so as to ensure that they are not included in planned requirements.</td>
<td></td>
</tr>
</tbody>
</table>

3. To save your changes, choose the **Update** button.

**Note**

The **Consume Forecast** field in purchase orders, as well as the **Consume Forecast** checkbox in purchase blanket agreements, is irrelevant for the consumption of forecast in MRP.

### Settings at Sales Order Level

**Note**

The procedure below describes only the steps that are relevant for defining the forecast consumption when creating or updating sales orders.

**Procedure**

1. From the SAP Business One **Main Menu**, choose **Sales - A/R → Sales Order**.
2. To display the **Consume Forecast** field, click (Form Settings).

3. For each item, from the **Consume Forecast** dropdown list, select one of the following options:
   - **Yes** – Reduces the quantity specified in the sales order from the forecast.
   - **No** – Prompts MRP to consider the sales order as an additional requirement.

4. To add the document to the system, choose the **Add** button.

   **Note**
   You can also update this field after adding the document, but only if the row was not copied to another document.

### Settings at Sales Blanket Agreement Level

**Note**

The procedure below describes only the steps that are relevant for defining MRP-related information when creating or updating sales blanket agreements.

**Procedure**

1. From the **Main Menu**, choose **Sales - A/R → Sales Blanket Agreement**.

2. In the general area, in the **Agreement Method** field, select the **Items Method** option, and define the **Start Date** and the **End Date** fields.

   **Note**
   MRP considers sales blanket agreements of **Item** agreement method only.
   It also considers the data from the sales blanket agreement that are relevant for the MRP planning horizon only.

3. On the **General** tab, in the **Agreement Type** field, choose the **Specific** option.

   From the **Status** dropdown list, select the **Approved** option.

   **Note**
   MRP considers sales blanket agreements of **Specific** type and **Approved** status only.
4. On the **Details** tab, define the item you want to include in the sales blanket agreement and enter the planned quantity.

5. To enter detailed information, double-click the item line. The **Row Details - Blanket Agreement** window appears.

6. Define the following mandatory fields and choose **Update**.

<table>
<thead>
<tr>
<th>Field/Checkbox</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
</table>
| **Frequency**  | To define the frequency at which you agreed to sell the item, select one of the following options:  
- Daily  
- Weekly  
- Monthly  
- Quarterly  
- Semi-Annually  
- Annually  
- One Time  |  |
| **From... To** | Define the date range to which the frequency applies. |  |
| **Quantity**   | Define the total quantity to be sold during the defined date range. | ► Example  
In the **Company Details** window, you have chosen the system to consider |
<table>
<thead>
<tr>
<th>Field/Checkbox</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warehouse</td>
<td>Define the warehouse from which the item will be sold.</td>
<td>Note If you do not define the warehouse, the sales blanket agreement will not be included in the MRP process.</td>
</tr>
<tr>
<td>Consume Forecast</td>
<td>Select this checkbox for MRP to reduce the quantity defined in this row from the forecast. If you deselect this checkbox, the quantity in this row is not subtracted from the forecast and is considered as a separate requirement in an MRP run.</td>
<td>Note MRP takes into account the item quantity from a sales blanket agreement that has been copied to sales orders. The item quantities in the sales orders based on a sales blanket agreement are subtracted from the sales blanket agreement and the remaining quantity in the sales blanket agreement is counted as its demand. The quantities in the mentioned sales orders are counted as demand coming from sales orders, not sales blanket agreements.</td>
</tr>
</tbody>
</table>

7. To add the document, choose Add. 
Using the MRP Wizard

The MRP wizard guides you through the process of defining new MRP scenarios and analyzing the MRP results. Afterwards, SAP Business One generates and displays the MRP recommendations.

MRP Wizard - Introduction Screen

Procedure
1. From the SAP Business One Main Menu, choose MRP → MRP Wizard.
   
   The MRP Wizard window opens.
   
   Choose the Next button.

Step 1 of 6 – Scenario Selection Screen

The MRP Scenario is a set of parameters defined by the user which are applied during the MRP run. You can define several MRP scenarios for each company, but only one scenario can be used for each MRP run (MRP calculation of the production or purchase orders).

In the Scenario Selection screen, select an existing MRP scenario or add a new scenario.

Procedure
1. To add a new scenario, select Create New Scenario. When you choose this option, two new fields appear:
   
   o Scenario Name – Specify a name for the new scenario. The name must be unique.
   
   o Description – Specify a description for the scenario.
   
   Choose Next; the Step 2 of 6 - Scenario Details screen appears.

   Note
   
   If no scenarios have been previously defined, the window opens in the Create New Scenario mode by default.

2. To include an existing scenario from the list, choose Select Existing Scenario. A table appears that contains all the existing scenarios.

3. The last scenario used is highlighted by default. To choose a different scenario, click the relevant row. The following information appears:

<table>
<thead>
<tr>
<th>Field</th>
<th>Activity/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MRP Scenario Name</td>
<td>Displays the name of the MRP scenario.</td>
</tr>
<tr>
<td>Description</td>
<td>Displays the description of the MRP scenario.</td>
</tr>
<tr>
<td>Start Date</td>
<td>Displays the first day of the first period of the scenario.</td>
</tr>
</tbody>
</table>
### Field | Activity/Description
--- | ---
**End Date** | Displays the last day of the last period of the scenario.

4. To execute the MRP run skipping the next steps, choose the *Run* button. This option is active only when you choose an existing scenario.

   **Note**
   
   You cannot change the name of an existing scenario, but you can change its description in the next window. You can reuse the name if you delete the MRP scenario.

   To delete an existing scenario, select the scenario and from the menu bar, choose Data → Remove.

5. To move on to the next step, choose Next; to go back to the previous step, choose Back.

## Step 2 of 6 – Scenario Details Screen

In the *Scenario Details* screen, specify all the necessary parameters for the MRP run.

![Scenario Details Screen](image)

### Procedure

1. Describe the MRP scenario.
   
   You can use the current description or change it.
2. Define the **Planning Horizon** section – the time period for the MRP run – from the first day of the MRP start period until the last day of the MRP end period. Specify the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start Date</strong></td>
<td>Specify the first day of the first period. When you use week periods, if the selected date is in the middle of the week, SAP Business One shifts it back to the first day of the week. MRP considers all the receipts and requirements that have a <em>Due Date</em> from the <em>Start Date</em> and later.</td>
<td>Note: The <em>Start Date</em> must be the current date or a date in the past. You cannot specify future dates.</td>
</tr>
<tr>
<td><strong>End Date</strong></td>
<td>Specify the last day of the last period. When you use week periods, MRP shifts the date forward to the last day of the week. MRP considers all the receipts and requirements that have a <em>Due Date</em> no later than the <em>End Date</em> of the MRP run.</td>
<td></td>
</tr>
<tr>
<td><strong>View Data in Periods Of</strong></td>
<td>Define the length of each period, displayed in the <strong>MRP Results</strong> window, in weeks, days, or months, depending on the selected option.</td>
<td>If you choose to group into period lengths other than one day, SAP Business One performs the MRP calculation on the first day of each period. MRP groups all the existing data for that period (receipts, requirements) in the first day. For weekly periods, the first day of the week is defined according to the holiday definition of the company.</td>
</tr>
<tr>
<td></td>
<td>✅ Example</td>
<td>If the value of the field is 4 weeks, then each period in the MRP run represents 4 calendar weeks.</td>
</tr>
<tr>
<td></td>
<td>✅ Example</td>
<td>A period of 1 week is defined. Week number 23 starts on June 2, 2014 and ends on June 8, 2014, according to the holiday definition of the company. MRP performs the calculation for the entire week as if all of the business activity happened on June 2, 2014, which is the beginning of the</td>
</tr>
<tr>
<td>Field</td>
<td>Activity/Description</td>
<td>Comments</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Planning Horizon Length</td>
<td>The field is calculated automatically when the start date and the end date are specified. It represents the number of periods – days, weeks, or months respectively. When you enter the value manually, MRP recalculates the entry in the End Date field.</td>
<td></td>
</tr>
</tbody>
</table>
| Consider Holidays For  | Define the types of items for which you want MRP to consider the holidays and weekends as defined in the holiday table. The following options are available:  
  - Production Items  
  - Purchase Items  
  MRP increases the lead time accordingly for the purchasing or production process.                                                                 | SAP Business One selects these checkboxes by default.                                                                                                                                  |
| Ignore Cumulative Lead Time | The setting of this checkbox is relevant for BOM items.  
   If you select this checkbox, the lead time is taken from the Lead Time field defined in the item master data of the item, and the MRP wizard does not take into account whether the child items will be available on time or not, it only takes into account if the parent item’s lead time meets the due date of the demand.  
   If you deselect this checkbox, the MRP wizard sums up the longest lead times of each BOM level in the recommendations, and if the child |                                                                                                                                                                                                  |
3. Define the Display Preferences section for the MRP run. Specify the following information:

<table>
<thead>
<tr>
<th>Field /Checkbox</th>
<th>Activity/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sort By</strong></td>
<td>This field defines the sorting criteria for the MRP report. From the dropdown list, choose one of four available sorting methods:</td>
</tr>
<tr>
<td></td>
<td>• Assembly Sequence – Sorts the report from the highest level of the BOM to the lowest level.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Example" /></td>
</tr>
<tr>
<td></td>
<td>See Example of Sort by Assembly Sequence.</td>
</tr>
<tr>
<td></td>
<td>• Item Number – Sorts the report by the item number.</td>
</tr>
<tr>
<td></td>
<td>• Item Description – Sorts the report by the item description.</td>
</tr>
<tr>
<td></td>
<td>• Item Group – Sorts the report by the item group.</td>
</tr>
<tr>
<td><strong>Display Items with No Requirements</strong></td>
<td>Select this checkbox to display items without actual requirements after the MRP run. Items without requirements are items that, during the entire MRP horizon, have a sufficient quantity and there is no need to create order recommendations for them.</td>
</tr>
<tr>
<td><strong>Simulation</strong></td>
<td>To define the scenario as a simulation scenario, select this checkbox. You cannot save simulation scenario recommendations or release them.</td>
</tr>
</tbody>
</table>

4. After you define all the necessary parameters or change existing ones, to save your selection, choose the Save Scenario button.
   You can use a saved scenario in other MRP runs.

5. To execute the report, choose the Run button, skipping the remaining steps.

   ![Note](image) You can execute the report at this point only if you are using an already saved scenario.

6. To move on to the next step, choose Next; to go to the previous step, choose Back.
Example of Sort by Assembly Sequence

In this example, three product trees are included. The low-level code 0 represents the finished goods, and the low-level codes 1, 2 and 3 represent subassemblies or raw materials.

<table>
<thead>
<tr>
<th>Low Level Code</th>
<th>BOM 1</th>
<th>BOM 2</th>
<th>BOM 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>A</td>
<td>F</td>
<td>X</td>
</tr>
<tr>
<td>1</td>
<td>B</td>
<td>E</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>D</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

When you select the **Sort by Assembly Sequence** option, the sorting is carried out according to the low-level code, with the result as follows: A, F, X, B, E, C, and D.

Step 3 of 6 – Item Selection Screen

In this screen, you define the items you want to include in the MRP run.

Procedure

1. To include all existing items, select the **All Items** radio button and choose **Next** to move to the next step.
2. To define specific items, select the **Selected Items** radio button and choose the **Add Items** button. The **Item List - Selection Criteria** window appears.
Define the criteria for the items to be included in the run and choose OK. The selected items are displayed in the table.

3. To remove all items, choose Remove Items.

To update all displayed items, choose Update Selected Items.

In the Items List - Update Selected Items window, you can update the following parameters:

- MRP Procurement Method
- MRP Order Interval
- MRP Order Multiple
- MRP Minimum Order Quantity
- MRP Lead Time
- MRP Tolerance Days

4. If you want to exclude an item from the MRP run, deselect the checkbox in the relevant item row.

5. To execute the report, choose the Run button, skipping the remaining steps.

6. To move on to the next step, choose Next; to go to the previous step, choose Back.
Step 4 of 6 – Inventory Data Source Screen

In the Inventory Data Source screen, specify which storage locations and warehouses to include in the MRP run, as well as the sources of demand and supply.

![Image of Inventory Data Source screen]

Procedure

1. In the Run By section, select one of the following:
   - **Company** - Consolidates existing inventory, demand, and supply and makes recommendations to the default warehouse.
     - **Note**
     - No recommendations for inventory transfer requests are made with this option.
   - **Warehouse** - Calculates existing inventory, demand, and supply at the warehouse level and makes recommendations for each warehouse separately.
     - **Note**
     - Recommendations for inventory transfer requests can be made with this option. For example, if in warehouse A there is a demand for a quantity that exists in warehouse B, SAP Business One recommends an inventory transfer request from warehouse B to the target warehouse.

2. To view all the warehouses listed in the Include Data Source table, choose the Expand button.
   For each warehouse, select the checkboxes for data sources you want to include in the MRP run:
   - **Include Existing Inventory**
   - **Include Demand**
   - **Include Supply**
Note

These settings are relevant regardless of whether you run MRP by company or by warehouse. For example, when you are running the MRP wizard by company, if you do not include demand from warehouse A, and the inventory level of the item is managed by warehouse, then MRP does not consider the demand from warehouse A.

3. To execute the report, choose the Run button, skipping the remaining step.
4. To move to the next step, choose Next.

Step 5 of 6 - Documents Data Source Screen

In this step, you specify the data sources to be taken into consideration, the documents to be included in the MRP run, and the Recommendations area settings.

Procedure

1. In the Time Range section, select one of the following radio buttons:

   - **Within Planning Horizon** - Only the documents within the start date and the end date range of the planning horizon, as defined in Step 2 of 6 – Scenario Details Screen, are considered in MRP calculations and displayed in the report. If the start date is earlier than the system date, consolidated data between the start date and the system date will appear in the Past Due Data column. The first period column will display data starting from today.

   - **Include Historical Data** - All demands and supplies before the start date are considered in the MRP calculations. Recommendations are summed and displayed in the system date column. The Historic Data field in the MRP report is visible only after you have selected the Include Historical Data checkbox in this step.
2. Specify the following fields in the section **Sources of Demand and Supply to Be Included in the MRP Calculation:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Purchase Orders</strong></td>
<td>Select this checkbox to consider open purchase orders in the report as supply.</td>
<td>If needed, you can include only specific documents in the MRP run. To do so, follow the steps below:</td>
</tr>
<tr>
<td><strong>Sales Orders</strong></td>
<td>Select this checkbox to consider open sales orders as supply in the MRP run.</td>
<td>1. Depending on the document type, select the relevant checkbox:</td>
</tr>
</tbody>
</table>
| **Production Orders**  | Select this checkbox to consider production orders in the report as expected receipts. |   o Restrict Purchase Orders  
   o Restrict Sales Orders  
   o Restrict Production Orders  
   o Restrict Reserve Invoice |
| **Reserve Invoice**    |                                                                                       | 2. The Selected Documents window appears listing the relevant documents. For each document you want to include in the MRP run, select the  
   Selected checkbox in the document row.                                                                                         |
| **Blanket Purchase Agreements** | Select this checkbox to consider blanket purchase agreements in the report as supply. | Caution                                                                                                                                 |
|                        |                                                                                       | The documents for which the Selected checkbox is deselected will not be included in the MRP run.                                       |

- **Note**
  - MRP considers only production orders with the status **Planned** or **Released**. Completed production orders are not relevant for calculation, because they have already impacted the inventory.
  - **Note**
    - For **Standard** production orders, in the MRP report, the system displays the parent items as supplies and the child items as demands.
    - For **Disassembly** production orders, in the MRP report, the system displays the parent items as demands and the child items as supplies.

- **Note**
  - This option is not available for the India localization.
  - When you select this checkbox, the system considers open reserve invoices and open correction invoices for reserve invoices in the MRP calculation.
    - For A/R reserve invoices and correction invoices, the system displays them as demand.
    - For A/P reserve invoices and correction invoices, the system displays them as supply.
<table>
<thead>
<tr>
<th>Field</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blanket Sales</td>
<td>Select this checkbox to consider blanket sales agreements in the report as demand.</td>
<td>Note MRP considers only the blanket agreements of type Specific and having Approved status.</td>
</tr>
<tr>
<td>Agreements</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inventory Transfer</td>
<td>Select this checkbox to consider inventory transfer requests in the MRP run.</td>
<td>- For the issuing warehouse, SAP Business One displays the requested quantities as demand.</td>
</tr>
<tr>
<td>Requests</td>
<td></td>
<td>- For the receiving warehouse, SAP Business One displays the requested quantities as supply.</td>
</tr>
<tr>
<td>Recurring Order</td>
<td>If you select this checkbox, SAP Business One considers recurring transactions that have been scheduled for sales and purchase order documents.</td>
<td>Note The MRP includes a recurring order transaction only when it contains the following data:</td>
</tr>
<tr>
<td>Transactions</td>
<td></td>
<td>- A quantity per item line</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- A warehouse per item line</td>
</tr>
<tr>
<td></td>
<td>To use one of the inventory levels specified in item master data as a demand in MRP calculation, select one of the following options:</td>
<td>Note When you are running MRP by company (as described in Step 4 of 6 – Inventory Data Source Screen), the application consolidates the inventory level requirements as one demand for the default warehouse.</td>
</tr>
<tr>
<td>Inventory Level</td>
<td>- Required</td>
<td>- On the Inventory Data tab of the Item Master Data window, if you have selected</td>
</tr>
<tr>
<td></td>
<td>- Minimum</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Maximum</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Activity/Description</td>
<td>Comments</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>the Manage Inventory by Warehouse checkbox for an item, the application sums up the inventory level values of all warehouses (Minimum, Maximum, and Required) for which the Include Demand checkbox is selected in Step 4 of 6 of the MRP wizard.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>o On the Inventory tab of the Item Master Data window, if you have deselected the Manage Inventory by Warehouse checkbox for an item, the application takes the defined company inventory level values (Minimum, Maximum, and Required) as a demand for all warehouses together.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>o When you are running MRP by warehouse (as described in Step 4 of 6 – Inventory Data Source Screen), the application considers inventory level requirements separately for each relevant warehouse.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>o On the Inventory tab of the Item Master Data window, if you have selected the Manage Inventory by Warehouse checkbox for an item, and in Step 4 of 6 of the MRP wizard, you have selected the Include Demand checkbox for one or more warehouses, the application takes the defined warehouse inventory level values (Minimum, Maximum, and Required) separately as relevant for the warehouses.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>o On the Inventory Data tab of the Item Master Data window, if you have deselected the Manage Inventory by Warehouse checkbox for an item, the application takes the company inventory level values (Minimum, Maximum, and Required) you defined respectively for each warehouse for which you have selected the Include Demand checkbox.</td>
<td>For example, if the defined Minimum in the item master data is 100 and you choose Minimum in this field, the system makes recommendations so that for each period the Final Inventory in each of the included warehouses is at least 100.</td>
</tr>
<tr>
<td>Forecast</td>
<td>If you want to consider forecast data in MRP calculation, in the dropdown list, choose one.</td>
<td></td>
</tr>
</tbody>
</table>
Field | Activity/Description | Comments
--- | --- | ---
| forecast, or choose Define New to define a new forecast. | Note | If you have defined sales orders and blanket sales agreements to consume forecast, in the MRP calculation, the forecast amount is reduced by the amount consumed on sales orders and blanket sales agreements. For more information, see Settings at Sales Order Level and Settings at Sales Blanket Agreement Level.

If you choose to consider a forecast in the MRP run, the system assigns a warehouse to the demands from the forecast according to the following rules:
- If you select only one warehouse in Step 4 of 6, the system links the demands from the forecast to this warehouse.
- If you select more than one warehouse in Step 4, and the default warehouse is one of them, the system links the forecast to the default warehouse.
- If you select more than one warehouse in Step 4 of 6, and the default warehouse is not one of them, the system links the forecast to the first warehouse code in ascending order.

Note: The consumption of forecasted amount by sales orders and blanket sales agreements is irrespective of the warehouse of the sales orders or the blanket sales agreements.

3. In the Recommendations section, to define the type of purchase documents you want the system to recommend for the items with the Procurement Method of Buy, select one of the following radio buttons:
   - Purchase Requests
   - Purchase Orders

4. The Production Orders checkbox is selected by default; the MRP wizard always makes recommendations for production orders, if required.

If you want the wizard to make recommendations for inventory transfers instead of purchase documents whenever there is an available quantity in another warehouse, select the Inventory Transfer Requests checkbox.
Note

The **Inventory Transfer Requests** checkbox is available only when you are running the MRP wizard by warehouse, that is, if in Step 4 of 6 under the **Run By** section, you have chosen the **Warehouse** radio button.

5. If you are running the MRP wizard by warehouse, to define for which warehouse you want the recommendations to be generated, choose one of the radio buttons:
   - **Generate to Default Warehouse for Item**
   - **Generate to Warehouse with the Demand**

Note

When you are running the wizard by company, the system generates recommendations to the default warehouse for the item by default.

6. To save the changes or to save a new scenario, choose the **Save Scenario** button. This button is active only if you make changes in the window.

7. To execute the report, choose the **Run** button.

### Step 6 of 6 – MRP Results Screen

The **MRP Results** screen appears after you run the MRP wizard and displays the results of the MRP run. You can see the schedule for the MRP demands on the **Report** tab, and view the outcome - the recommendations that assemble the demands - on the **Recommendations** tab.

The outcome of the wizard is a list of recommendations for production orders, purchase orders (or purchase requests), and inventory transfer requests - depending on your definitions. To issue actual orders, from the saved recommendations for a given scenario, you must use the order recommendation function. For more information, see Creating Order Recommendations.
General Area

Procedure

1. View the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Activity/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planning Horizon</td>
<td>Displays the dates of the MRP period as defined in the Scenario Details screen.</td>
</tr>
<tr>
<td>Calculated At</td>
<td>Displays the date and the time at which you ran the MRP report.</td>
</tr>
<tr>
<td>Find Item No.</td>
<td>Enter the code of the item you want to locate in the report. The application then scrolls the report to the row where this item code appears.</td>
</tr>
<tr>
<td>Finish</td>
<td>Exits the wizard. If the recommendation is not saved, MRP displays a warning message.</td>
</tr>
</tbody>
</table>

MRP Results Screen - Report Tab – Collapsed View

Use the Report tab to view the plan the MRP wizard scheduled to satisfy your inventory demands during the defined period. The table displays MRP data in columns representing data periods according to the settings in Step 2 of 6 of the MRP wizard. The item row displays recommended quantities in bold.

If you defined more than one day/week/month in the View Data in Periods Of field in Step 2 of 6 of the MRP wizard, the title of each column displays the first day/week/month of the period in the chosen format, and the data of each column represents the sum data of the specified period of time.

The collapsed view is the default view of the Report tab.

Procedure

1. View the information in the table columns of the MRP Results screen – Collapsed view:

<table>
<thead>
<tr>
<th>Column</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item No.</td>
<td>Displays the number of the parent and child items.</td>
<td></td>
</tr>
<tr>
<td>Item Description</td>
<td>Displays the description of the item.</td>
<td></td>
</tr>
</tbody>
</table>
| Historic Data   | The total quantity of Initial Inventory, supply, gross demand, and final inventory before the start date of the planning horizon. | Note: This column is visible only if you have selected the Include Historic Data radio button in Step 5 of 6 of the MRP wizard. Note: No order recommendations are
<table>
<thead>
<tr>
<th>Column</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Past Due Data</strong></td>
<td>Displays a consolidated value summing up all the data that falls into the past due period. The past due period starts from the Start Date of the planning horizon and ends with the current system date (not including the current date). Therefore, when the Start Date is later than the current system date, there is no past due period.</td>
<td>If the MRP run results in negative ending inventory for a specific item in the past due period, MRP does not recommend making or buying items for that period. The negative inventory is passed on to the current period (next after past due).</td>
</tr>
<tr>
<td><strong>Future Data</strong></td>
<td>Displays a consolidated value summing up all the data that falls into the future period. The future period is the lead time period that starts right after the End Date of the planning horizon. The future period of each item may vary because of different definitions for lead time.</td>
<td>You define a 10-day lead time for item A; therefore, the Future Data column displays the data of this item for the 10 days after the planning horizon.</td>
</tr>
</tbody>
</table>

**Note**

To display the Item Group field, click (Form Settings) in the toolbar. You can also define whether to display the column headers for the MRP results in an abbreviated or long format.

2. The right side of the table represents the MRP horizon periods as defined in the scenario.
   - If the data is grouped into periods of several days, the title of each column displays the first day of the period in the chosen format.
   - If the data is grouped into periods of weeks (for example, a period of 4 weeks), the title of each column displays the first week of the period in the chosen format.

   To scroll through the columns, use the scroll bar at the bottom of the table.

3. The fields in the horizon period columns display the quantity to be ordered as recommended by the MRP run.
   The cells in the table are different colors to provide an indication of their status:

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
</table>
| White      | White indicates there are more receipts than requirements; therefore, the item’s quantity is sufficient and there is no need to issue the production or purchase recommendations. Only the item row can be white; the Initial Inventory, Supply, Demand, and Final Inventory rows are always either light grey or dark grey. |   | Today is July 3, 2014.  
    | Light Grey | There are two options for this indication:  
    | |   - The item has no data for the given period.  
    | |   - The item has order recommendations and, according to the item’s lead time (defined in the Item Master Data window), there is  
    | |   | Today is July 3, 2014.  
    | | | A production order for a certain parent item is due on July 8, 2014.  
    | | | The lead time of the item is 3
### Color Description

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sufficient time to produce or to purchase the item. In this case, the quantity appears in black.</td>
<td>Note MRP always calculates sufficient lead time taking the present date into consideration.</td>
<td></td>
</tr>
<tr>
<td>Dark Grey</td>
<td>Represents the periods with insufficient time to complete the production or purchase order. In this case, the recommendation and supply quantity appear in red, indicating that the recommendation cannot be completed to provide sufficient inventory before the due date. The cells are dark grey regardless of the demands for production or purchase orders in these periods. The recommendation for the item is issued anyway with the remark ‘Past Due’. The ‘MRP Dependent Requirements’ are also issued for the child item. <em>Past Due Data</em> and <em>Historic Data</em> are always displayed in dark grey.</td>
<td>• Today is July 14, 2014.&lt;br&gt;• The lead time of the item is 3 days; hence, the cells for July 14, 15 and 16 are dark grey. To complete the order by the due date of July 16, 2014, the production or purchase orders for the children should have been issued on July 13. This date is in the past; therefore, the process cannot be completed on time and the cell is dark grey.</td>
</tr>
</tbody>
</table>
Example 1

**General Data**

- Parent item (BOM1)
  - Procurement method: Make
  - Lead time: 2 days
- Child item (Child1)
  - Procurement method: Make
  - Lead time for the child item: 2 days
- Grandchild item (Grandchild1)
  - Procurement method: Buy
  - Lead time: 2 days
- There is a requirement for a sales order for 5 pieces of BOM1 on June 30.
- There are no other requirements or receipts for any of the items in the bill of materials.
- No forecast is included in the MRP run.
- Start Date: June 25
- End Date: July 1st
- Present Date: June 25
- Weekends are defined as work days
- In Step 2 of 6 of the MRP wizard, the *Ignore Cumulative Lead Time* checkbox is deselected.
MRP Wizard Results

To meet the sales order demand on June 30th, a recommendation for a production order of BOM1 should be scheduled for June 28th, due to the two-day lead time. Child1 should be available on June 28th so that the production order can be processed, and due to its two-day lead time, a production order for Child1 should be scheduled for June 26th. Grandchild1 should hence be available on June 26th, and due to its lead time, a purchase request should be scheduled for June 24th.

However, since it is already June 25th and this is the earliest date that Grandchild1 can be ordered; it will be available on June 27th and the production order for Child1 is therefore scheduled for June 27th, as displayed above. The lead time for Child1 to be produced is two days; therefore, BOM1 can enter production on June 29th and be available for sale on July 1st. This means that the demand from June 30th cannot be met on time and all the recommendations in this chain are displayed in red.
Example 2

General Data
Data from Example 1 apply, except that the *Ignore Cumulative Lead Time* checkbox is selected.

MRP Wizard Results

![MRP Wizard Results](image)

To meet the requirement from June 30th, a production order is scheduled for June 28th. The recommendation is in black because the wizard does not take into account the lead time of the child or the grandchild. Since BOM1 is scheduled for production on June 28th, Child1 needs to be available on this date; therefore, a production order is scheduled for June 26th. This recommendation is in black, and because the lead time of Child1 meets the due date of the demand, the system does not take into account the lead time of any items at the lower levels (in this case, Grandchild1).

To meet the requirement from June 26th - the production order of Child1 - Grandchild1 needs to be available on the same date. Due to its two-day lead time, it should be ordered on June 24th; however, the earliest date it can be ordered is June 25th. This recommendation is in red because it will not meet the due date of the requirement, as it will be available on June 27th.
Examples of Planning Policy

Example 1 - Order Multiple

This example explores how the planning policy (as shown in the MRP process diagram) affects an MRP run.

General Data
- Parent item (BOM1)
  - Procurement method: Make
  - Lead time: 2 days
  - Order Multiple: 3
- Child item (Child1)
  - Procurement method: Make
  - Lead time for the child item: 2 days
- Grandchild item (Grandchild1)
  - Procurement method: Buy
  - Lead time: 0 days
- There is a requirement for a sales order for 5 pieces of BOM1 on June 30th.
- There are no other requirements or receipts for any of the items in the bill of materials.
- No forecast is included in the MRP run.
- Start Date: June 25th
- End Date: July 1st
- Present Date: June 25th
- Weekends are defined as work days
- In Step 2 of 6 of the MRP wizard, the Ignore Cumulative Lead Time checkbox is deselected
Five pieces are required to meet the demand of the sales order on June 30th. The planning policy is for multiples of 3 for the parent item. A recommendation for a production order of 6 pieces is scheduled for June 28. Therefore, an MRP requirement for Child1 is also for 6 pieces and scheduled for June 26 due to its two-day lead time. The MRP requirement for the grandchild should be issued on June 26th for 6 pieces.

**Example 2 - Order Interval**

**General Data**
- Item No. Item5
  - Procurement method: Buy
  - Lead time: 2 days
  - Order Interval: Weekly on Monday
- There are sales orders for July 13, July 16, July 23, and August 1, each for a quantity of 1. The quantities in the sales orders are set not to consume forecast.
- Start Date: July 6
- End Date: August 5
- Present Date: July 6
- Weekends are defined as work days.
- In Step 2 of 6 of the MRP wizard, the *Ignore Cumulative Lead Time* checkbox is deselected
- Forecast is included in the MRP run as displayed below:

<table>
<thead>
<tr>
<th>Week 28 (July 7 - July 13)</th>
<th>Week 29 (July 14 - July 20)</th>
<th>Week 230 (July 21 - July 27)</th>
<th>Week 31 (July 28 - August 3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantity</td>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
</tbody>
</table>

View the recommendations for the first 14 days.
Although the order interval is set to every Monday, there is a demand on July 7, which needs to be fulfilled as soon as possible, that is, today. A purchase order is, therefore, scheduled for today, and the quantity is in red because the due date is past the date of the demand (the lead time of the item is two days).

The next recommendation is scheduled on July 14, Monday. Since the items arrive two days later, on July 16, the demand from July 16 is satisfied.

View the recommendations for the last 15 days.

Another purchase order is recommended on Monday, July 21. The demand from July 23 is satisfied and the next recommendation is scheduled for Monday, July 28 to meet the demand from August 1.

The demand coming from the forecast is grouped according to the definitions in the Forecast window. Since in the View field we chose the Weekly option, the demand from the forecast is grouped into weeks, and for each week it falls on the first day. In this case, according to the company settings, it is Monday.

Report Tab - Expanded View

Each row in the table can be expanded into 4 additional rows by choosing the Expand/Collapse button. The expanded table displays a detailed list of initial inventory, supplied and demanded quantities and the final inventory for each period.
View the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Initial Inventory</strong></td>
<td>Displays the initial quantity in stock of the item, for every given period. This quantity is based on the existing inventory of the current date. For every other period, the initial inventory derives from the final inventory of the previous period.</td>
<td></td>
</tr>
<tr>
<td><strong>Supply</strong></td>
<td>Displays the expected positive entries of the item to the stock depending on the definitions in Steps 4 and 5 of the MRP wizard.</td>
<td>If there is a quantity in one of the cells in the <strong>Supply</strong> row, it is possible to see the detailed list of data sources. For more information, see Pegging Information for Supply.</td>
</tr>
<tr>
<td><strong>Demand</strong></td>
<td>Displays the expected inventory releases of the item for the column’s time period depending on the definitions in Steps 4 and 5 of the MRP wizard.</td>
<td>If there is a quantity in one of the cells in the <strong>Demand</strong> column, it is possible to see the detailed list of data sources. For more information, see Pegging Information for Demand.</td>
</tr>
<tr>
<td><strong>Final Inventory</strong></td>
<td>When you select the <strong>Preview MRP Run Results</strong> checkbox, this row displays the quantity remaining in the inventory after MRP recommendations are issued. When you deselect the <strong>Preview MRP Run Results</strong> checkbox, this row displays final quantity calculated according to <strong>Initial Inventory</strong>, <strong>Supply</strong>, and <strong>Demand</strong> only.</td>
<td></td>
</tr>
<tr>
<td><strong>Preview MRP Run Results</strong></td>
<td>See the explanation for <strong>Final Inventory</strong> above.</td>
<td></td>
</tr>
<tr>
<td><strong>Filter Possible Problem Items</strong></td>
<td>If you select this checkbox, the wizard displays the items for which demand cannot be met (that is, those for which recommendations are in red).</td>
<td></td>
</tr>
</tbody>
</table>

Pegging Information for Supply

**Procedure**

1. To open the receipts **Pegging Information – XXX** (MRP scenario name) window, click a cell displaying an amount in the **Supply** row in the **MRP Results** screen.

   The **Pegging Information** window opens.
2. View the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Activity/Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Number</td>
<td>Displays the number of the item supplied.</td>
</tr>
<tr>
<td>Description</td>
<td>Displays the item description.</td>
</tr>
<tr>
<td>Period From... To</td>
<td>Displays the first and the last date of the period to which the pegging information relates.</td>
</tr>
<tr>
<td><strong>Supply Details</strong></td>
<td></td>
</tr>
<tr>
<td>Source</td>
<td>Displays the number of the document. To open the document, choose (Link Arrow).</td>
</tr>
<tr>
<td>Type</td>
<td>Displays one of the following document types:</td>
</tr>
<tr>
<td></td>
<td>- Production order (for parent items)</td>
</tr>
<tr>
<td></td>
<td>- Purchase order or purchase request</td>
</tr>
<tr>
<td></td>
<td>- A/P reserve invoice</td>
</tr>
<tr>
<td></td>
<td>- Blanket purchase agreement</td>
</tr>
<tr>
<td></td>
<td>- Recurring purchase transaction</td>
</tr>
<tr>
<td></td>
<td>- Inventory transfer request</td>
</tr>
<tr>
<td></td>
<td>- MRP recommendation</td>
</tr>
<tr>
<td>Note</td>
<td>The source types displayed depend on the definitions you made in Step 5 of 6 of the MRP wizard.</td>
</tr>
<tr>
<td>Due Date</td>
<td>Displays the due date of the corresponding document.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Displays the open quantity of the item from the production order or the purchase order.</td>
</tr>
<tr>
<td>Whse</td>
<td>The warehouse to which the supply is directed.</td>
</tr>
<tr>
<td>Remarks</td>
<td>Denotes if the supply comes from an already existing</td>
</tr>
</tbody>
</table>
3. To close the window, choose the **OK** button.

### Pegging Information for Demand

**Procedure**

1. To open the *Pegging Information – XXX* (MRP scenario name) window, click a cell displaying an amount in the **Demand** row in the **MRP Results** window.

   The *Pegging Information* window opens. The title of the window shows the scenario name.

   ![Pegging Information Window](image)

2. The header of the window is similar to that of the *Pegging Information* window for **Supply**: it displays the **Item Number, Description**, and the first and last date of the period this pegging information relates to.

3. View the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Activity/Description</th>
</tr>
</thead>
</table>
| **Source** | Displays the following:  
- The number of the production order (relevant for child items)  
- The number of the sales order  
- The name of the forecast  
- Parent item number for an MRP-dependent requirement for production of the parent  
- The item number for the minimum inventory level  
- The number of the inventory transfer request | Comments |
<table>
<thead>
<tr>
<th>Field</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Displays the type of the requirement:</td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>• Sales order</td>
<td>The source types displayed depend on the definitions you made in Step 5 of 6 of the MRP.</td>
</tr>
<tr>
<td></td>
<td>• Production order</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• A/R reserve invoice</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Minimum inventory level</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Forecast</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MRP requirement (for child items)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Recurring sales transaction</td>
<td></td>
</tr>
<tr>
<td><strong>Due Date</strong></td>
<td>Displays the due date of the relevant document. If the source is an MRP requirement, the calculated due date of the parent item is displayed.</td>
<td><strong>Example</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>There is an MRP recommendation for a production order on 15 July 2014. The due date of the MRP requirement for the child item will be on 15 July 2014 regardless of the period related to this requirement.</td>
</tr>
<tr>
<td><strong>Quantity</strong></td>
<td>Displays the open quantity of the item from sales orders and planned quantity from production orders. For forecasts, the field displays the quantity that was not consumed by sales orders or blanket agreements.</td>
<td></td>
</tr>
</tbody>
</table>

**Note**

When there are gross requirements for an item that is an assembly or a sales bill of materials, MRP issues no actual recommendations for production for the parent item. MRP generates a compensation entry in the item's **Receipts** row to clear the final quantity.

MRP dependent requirements for the child items are issued regularly, similar to a production bill of materials.
Pegging Information for Recommendations

Procedure

1. To open the Pegging Information – XXX (MRP scenario name) window, click a cell displaying an amount in the Recommendations row in the MRP Results window.

2. The Pegging Information window opens. The title of the window shows the scenario name.

3. The header of the window is similar to that of the Pegging Information window for supply and demand; it displays the Item Number, Description, and the first and last date of the period to which this pegging information relates.

4. View the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>This field is irrelevant for the recommendations row because there are no existing documents yet.</td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>Displays the type of the recommendation:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Purchase order or purchase request</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Production order</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Inventory transfer request</td>
<td></td>
</tr>
<tr>
<td>Note</td>
<td></td>
<td>The source types displayed depend on the definitions you made in Step 5 of 6 of the MRP.</td>
</tr>
<tr>
<td>Due Date</td>
<td>Displays the due date of the relevant document.</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Activity/Description</td>
<td>Comments</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Quantity</td>
<td>Displays the recommended quantity of the item.</td>
<td></td>
</tr>
</tbody>
</table>

5. To close the window, choose the **OK** button.
### MRP Results Screen – Recommendations Tab

This tab displays a list of the recommended documents you should issue according to the MRP calculation. The values in the window are informative only. To make changes to the recommended documents, or to issue actual orders and inventory transfer requests, see Creating Order Recommendations.

#### Procedure

1. View the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order Type</td>
<td>Displays the type of the MRP recommendation: production order, purchase order, or inventory transfer request.</td>
<td></td>
</tr>
<tr>
<td>Item No.</td>
<td>Displays the number of the item.</td>
<td></td>
</tr>
<tr>
<td>Item Description</td>
<td>Displays the description of the item.</td>
<td></td>
</tr>
<tr>
<td>Quantity</td>
<td>Displays the quantity recommended by MRP.</td>
<td></td>
</tr>
<tr>
<td>UoM Code, UoM Name</td>
<td>Displays the unit of measurement as defined in the item master data of the item.</td>
<td></td>
</tr>
</tbody>
</table>

For purchase items: *Purchasing Data* tab
You can manually change this default UoM to any purchasing UoM before generating the recommendations.

For production items: *Inventory Data* tab
For transferred items: *Inventory Data* tab
### Field | Activity/Description | Comments
--- | --- | ---
**Release Date** | The date on which the recommended document should be released to meet its due date, depending on the lead time of the item. | The date in this field cannot be earlier than today.

**Due Date** | Displays the suggested due date for the recommended quantities. If the recommended document is past due, according to the items’ lead time, the due date appears in red. | Example
- Today is July 15, 2014.
- The child item’s procurement method is ‘Buy’ and it has a lead time of 3 days. The due date of the purchase order is July 16, 2014. Although this date is in the future, it is still in red. There is not enough time to receive the order according to the child item’s lead time (July 13, 2014, which is 3 days before the due date and is in the past).

**Vendor Code** | Displays the preferred vendor code of the item recommended in a purchase order or purchase request (as defined in Item Master Data → Purchasing Data tab → Preferred Vendor). |

**Unit Price** | Displays the price from the price list linked to the preferred vendor. Note that if special prices are defined for the linked preferred vendor, these are displayed instead (according to the standard behavior of prices in SAP Business One). |

**Discount %** | Displays the discount defined for the item’s price list. |

**Price After Discount** | Displays the unit price after subtracting the discount. |

**From Whse** | 1. **Note**
This field is relevant for inventory transfer requests only.
Displays the warehouse that issues the inventory in an inventory transfer. |

**To Whse** | For production orders, it displays the warehouse that receives the finished product, as defined in the bill of materials of
### How to Configure and Use MRP in SAP Business One 9.0

#### Using the MRP Wizard

<table>
<thead>
<tr>
<th>Field</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>the parent item. For purchase orders and purchase requests, it displays the warehouse according to your definitions in Step 5 of 6 of the MRP wizard:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If you select the <em>Generate to Default Warehouse</em> for the <em>Item</em> radio button, the application displays the item’s default warehouse as defined in the item master data.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If you select the <em>Generate to Warehouse with the Demand</em> radio button, the application displays the warehouse that has the demand to procure this item.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For inventory transfer requests, it displays the receiving warehouse in the inventory transfer.</td>
<td></td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td>Displays the order’s total amount according to the <em>Quantity * Price After Discount</em>.</td>
<td></td>
</tr>
<tr>
<td><strong>Exception</strong></td>
<td>Displays the <em>Past Due</em> remark for orders that are past due according to the lead time definitions (their due date is in red).</td>
<td></td>
</tr>
</tbody>
</table>

**Note**

To display additional fields, choose *(Form Settings)* on the toolbar.

2. To save the recommendations for the current MRP run, choose the *Save Recommendations* button.

   SAP Business One saves recommendations for each scenario.

   If there are previous recommendations for the current scenario, the system displays the following message:

   ```
   System Message
   There are previous recommendations for the current scenario that will be deleted.
   Continue?
   ![System Message](image)
   ```

   To save the new recommendations, choose the *Yes* button.

   To go back to the *MRP Results* window, choose the *No* button.

3. To exit the wizard, choose the *Finish* button. If the results are not saved, the system displays the following message:
Choose one of the buttons displayed:

- **Yes** – saves the recommendations and exits the MRP wizard.
- **No** – exits the **MRP Wizard** without saving.
- **Cancel** – goes back to the **View Recommendation** window without saving.

4. To review and create actual production or purchase orders from the **MRP Results** window, use one of the following methods:
   
   - Right-click the header area and choose **Order Recommendation**.
   - From the **Go To** menu, choose **Order Recommendation**.
Creating Order Recommendations

After you have saved the recommendations in an MRP run, you can use the order recommendations functionality to modify them if needed and execute the orders.

**Prerequisite**

You have saved the recommendations in an MRP wizard run.

**Procedure**

1. From the SAP Business One Main Menu, choose MRP → Order Recommendation. The Order Recommendation – Selection Criteria window opens.

2. Specify the following information:

<table>
<thead>
<tr>
<th>Field/Area</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
</table>
| **Order Type**      | Specify one of the following types of MRP recommendation you would like to display in the report:  
                      | • All  
                      | • Production Orders  
                      | • Purchase Orders  
                      | • Inventory Transfer Requests  
                      | • Purchase Quotations  
                      | • Purchase Requests                                                                 |
| **Scenario**        | MRP recommendations are saved for each scenario. Specify the scenario you would like to view in the report. The scenarios defined as Simulation are not available for selection. |
| **Due Date From... To** | Filters the report according to the due date of the orders. |
# How to Configure and Use MRP in SAP Business One 9.0

## Creating Order Recommendations

<table>
<thead>
<tr>
<th>Field/Area</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Release Date From</strong>... <strong>To</strong>...</td>
<td>Filters the report according to the release date of the orders.</td>
<td></td>
</tr>
<tr>
<td><strong>Items</strong></td>
<td>Define the standard item selection fields, similar to other reports in SAP Business One.</td>
<td></td>
</tr>
<tr>
<td><strong>Vendors</strong></td>
<td>Define the standard vendor selection fields, similar to other reports in SAP Business One. Filters the documents which contain the selected vendors as preferred vendors.</td>
<td>This option is available only when you select any purchasing document type or <strong>All</strong> in the <strong>Document Type</strong> field.</td>
</tr>
</tbody>
</table>

### Note

This option is available only when you select any purchasing document type or **All** in the **Document Type** field.

3. To display the **Order Recommendation**, choose the **OK** button.

The **Order Recommendation** window opens.

```
<table>
<thead>
<tr>
<th>Field</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Find Item No.</strong></td>
<td>Use this field to locate a certain item row.</td>
<td>The value you search by is determined by the column you choose to use as the sorting criteria.</td>
</tr>
<tr>
<td><strong>Create</strong></td>
<td>Select this checkbox for the documents that you want to create.</td>
<td>To select all recommendations, double-click the column header.</td>
</tr>
</tbody>
</table>
```

This window is very similar to the **Recommendations** tab in the **MRP Results** window. However, here you can update almost all the fields in the table, create documents from saved order recommendations, and delete recommendations.

4. View or specify the following information:
### Order Type

If needed, you can choose a different order type for each recommendation. You can do the following:

- Change a production order to a purchase order, if a production Bill of Materials exists for the item.
- Change a purchase order to a production order, if you can specify a vendor for the order.
- Change a purchase order to purchase quotation and create the purchase order based on the vendor’s quotes.

**Note**

If you create a purchase quotation from the order recommendation, the application creates quotations for all the preferred vendors listed in the item master data. If you have not specified any preferred vendor, you receive the following error message “No records found; maintain preferred vendors list for item”.

- Change purchase orders and production orders to inventory transfer requests, so as to satisfy the demands, using the existing inventory in other warehouses.

**Note**

If you create an inventory transfer request from the order recommendation, make sure that you specify the From Warehouse and the To Warehouse fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order Type</td>
<td>If needed, you can choose a different order type for each recommendation. You can do the following:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Change a production order to a purchase order, if a production Bill of Materials exists for the item.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Change a purchase order to a production order, if you can specify a vendor for the order.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Change a purchase order to purchase quotation and create the purchase order based on the vendor’s quotes.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
<td>If you create a purchase quotation from the order recommendation, the application creates quotations for all the preferred vendors listed in the item master data. If you have not specified any preferred vendor, you receive the following error message “No records found; maintain preferred vendors list for item”.</td>
</tr>
<tr>
<td></td>
<td>- Change purchase orders and production orders to inventory transfer requests, so as to satisfy the demands, using the existing inventory in other warehouses.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
<td>If you create an inventory transfer request from the order recommendation, make sure that you specify the From Warehouse and the To Warehouse fields.</td>
</tr>
<tr>
<td>Item Number</td>
<td>Displays the number of the item. You can update this field with a different item number. To select an alternative item, right-click the Item Number field and choose Alternative Items.</td>
<td><strong>Note</strong> A relevant message is displayed if there are no alternative items defined for this item.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Displays the quantity recommended by MRP. You can specify a different quantity if required.</td>
<td></td>
</tr>
<tr>
<td>Due Date</td>
<td>Displays the suggested due date for the document. If the recommended order is past due, depending on the item’s lead time, the due date appears in red. You can update the due dates manually, as required.</td>
<td></td>
</tr>
<tr>
<td>Vendor Code</td>
<td>Displays the preferred vendor code of the item. You</td>
<td></td>
</tr>
</tbody>
</table>
Creating Order Recommendations

<table>
<thead>
<tr>
<th>Field</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>can choose a different vendor or select one manually.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Unit Price</strong></td>
<td>Displays the price from the price list linked to the preferred vendor. If special prices are defined for the linked preferred vendor, these are displayed instead (depending on the standard behavior of prices in SAP Business One). You can update the price manually.</td>
<td></td>
</tr>
<tr>
<td><strong>Discount %</strong></td>
<td>Displays the discount defined for the price list of the item. If you change this field, the <em>Price After Discount</em> and the <em>Total</em> fields are updated accordingly.</td>
<td></td>
</tr>
<tr>
<td><strong>From Whse</strong></td>
<td>Displays the warehouse that issues the inventory in an inventory transfer request.</td>
<td>Note: This field is valid and editable only for recommendations with the <em>Order Type of Inventory Transfer Requests</em>.</td>
</tr>
<tr>
<td><strong>To Whse</strong></td>
<td>Displays the warehouse that receives the procured quantity. You can change the warehouse if necessary.</td>
<td>You choose the default warehouse as follows:</td>
</tr>
<tr>
<td></td>
<td><strong>•</strong> For production order recommendations, by default, the application displays the warehouse defined in the bill of materials for this parent item.</td>
<td>• For <em>Buy</em> items, choose the warehouse based on the definitions on the <em>Inventory Data</em> tab in the <em>Item Master Data</em> window. If there is no default warehouse for the item, this information derives from General Settings → Inventory tab → Default Warehouse.</td>
</tr>
<tr>
<td></td>
<td>• For purchase order recommendations, by default the application displays the warehouse according to your warehouse definition in Step 5 of 6 of the MRP wizard.</td>
<td>• For <em>Make</em> BOM items, the default warehouse is based on the BOM definition.</td>
</tr>
<tr>
<td></td>
<td>• If you choose the <em>Generate to Default Warehouse for Item</em> checkbox, the system displays the item's default warehouse as defined in item master data.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If you choose the <em>Generate to Warehouse with the Demand</em> checkbox, the system displays the warehouse that has the demand to procure this item.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• For inventory transfer requests, the application displays the receiving warehouse in the inventory transfer.</td>
<td></td>
</tr>
<tr>
<td><strong>Items Exception</strong></td>
<td>Displays the <em>Past Due</em> remark for items whose recommendations were created with a due date in the past, or where the length of the lead time</td>
<td></td>
</tr>
</tbody>
</table>
Creating Order Recommendations

Field | Activity/Description | Comments
---|---|---
| | precludes meeting the due date. | 

1. **Note**

The information described above relates only to the active fields. For information on the informative fields, see MRP Results Screen –Recommendations.

5. You can define the numbering series of the documents and display additional fields by choosing **(Form Settings)** in the toolbar.

Specify the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Activity/Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Consolidate Recommendations</strong></td>
<td>Select this checkbox to group the recommendations for the purchase orders related to the same vendor into one document. If the recommendations have the same vendor, item, warehouse, and delivery date, they are grouped into the same row in the purchase order document.</td>
<td>By consolidating the recommendations, you can minimize the number of generated documents and thus reduce logistics activities and maintenance costs. You can also achieve greater quantity-related discounts.</td>
</tr>
<tr>
<td><strong>Production Order Series</strong></td>
<td>For each document type, select the desired numbering series from the dropdown list.</td>
<td>The default series is the one that was defined as such in the Document Numbering - Setup window.</td>
</tr>
<tr>
<td><strong>Purchase Order Series</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Purchase Quotation Series</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Inventory Transfer Request Series</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Purchase Request Series</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

6. To create the selected orders, choose **Update**.

If you create orders, a system message appears that states how many orders were created.
Note

"MRP" is entered automatically in the Origin field in the created production orders. The remark "Origin: MRP" is entered automatically in the Remarks field in the purchase orders created.
Printing MRP Recommendations

With SAP Business One you can print MRP recommendations using default print templates.

Procedure
1. In the Tools menu, choose Layout Designer, or click in the toolbar.
2. Choose the preferred printing template.
3. From the File menu, choose Print, or click in the toolbar.

Note
You can edit the default templates or create new ones by using Print Layout Designer. For more information about Print Layout Designer, see the document How to Customize Printing Layouts with Print Layout Designer in the documentation area of the SAP Business One Customer Portal at http://service.sap.com/smb/sbocustomer/documentation.
Authorizations

For information about the authorizations required for MRP, see the online help for SAP Business One and the document How to Define Authorizations in the documentation area of SAP Business One Customer Portal at http://service.sap.com/smb/sbocustomer/documentation.
Example 1: Procurement Method

- A box of chocolates is a parent item in a production BOM, composed of a wooden box and 25 chocolates as child items.
- The box is purchased from an external vendor and the chocolates are produced by your company.

The *Make* procurement method should be chosen for the box of chocolates item and the chocolate items and a *Buy* procurement method for the wooden box. As a result, to make one box of chocolates, MRP issues the recommendations for quantities needed to assemble the product, which is a production order for 25 chocolates and a purchase order for one wooden box.

Example 2: Consumption Method

This is an example of a sales forecast and its consumption by a sales order.

The *Backward-Forward* method of the forecast consumption was selected with a range of 10 days backward and forward.

The forecast was defined as follows:

<table>
<thead>
<tr>
<th>Item No.</th>
<th>01/15/14</th>
<th>01/16/14</th>
<th>02/15/14</th>
<th>03/01/14</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAB2004</td>
<td>10</td>
<td>20</td>
<td>20</td>
<td>40</td>
</tr>
</tbody>
</table>
The following sales orders were received:

<table>
<thead>
<tr>
<th>Document No.</th>
<th>Item No.</th>
<th>Due Date</th>
<th>Quantity</th>
<th>Consume Forecast (from the Sales Order)</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>10001</td>
<td>TAB2004</td>
<td>01/01/2014</td>
<td>5</td>
<td>YES</td>
<td>No forecast found in the defined range.</td>
</tr>
<tr>
<td>10002</td>
<td>TAB2004</td>
<td>01/06/2014</td>
<td>5</td>
<td>YES</td>
<td>5 pieces are subtracted from 01/15.</td>
</tr>
<tr>
<td>10003</td>
<td>TAB2004</td>
<td>01/16/2014</td>
<td>100</td>
<td>NO</td>
<td>An additional unexpected requirement, which is not on the account of the forecast.</td>
</tr>
<tr>
<td>10004</td>
<td>TAB2004</td>
<td>01/20/2014</td>
<td>20</td>
<td>YES</td>
<td>20 pieces are subtracted from 01/16.</td>
</tr>
<tr>
<td>10005</td>
<td>TAB2004</td>
<td>02/25/2014</td>
<td>30</td>
<td>YES</td>
<td>20 pieces are subtracted from 02/15 and 10 pieces are subtracted from 03/01.</td>
</tr>
</tbody>
</table>

**Note**

The calculation is always done from the earliest sales order to the latest according to their due dates.
The forecast represents the company’s projection for future sales. If there is an actual order on the account of the forecast, the sales order replaces it. Only the forecast that was not consumed by the sales order is considered during the MRP run, as displayed in the table below.

### The forecast after consumption

<table>
<thead>
<tr>
<th>Item No.</th>
<th>01/15/08</th>
<th>01/16/08</th>
<th>02/15/08</th>
<th>03/01/08</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAB2004</td>
<td>5</td>
<td>0</td>
<td>0</td>
<td>30</td>
</tr>
</tbody>
</table>

### Net Requirements (Forecast + Sales Orders)

<table>
<thead>
<tr>
<th>Item No.</th>
<th>01/01</th>
<th>01/06</th>
<th>01/15</th>
<th>01/16</th>
<th>01/20</th>
<th>02/25</th>
<th>03/01</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAB2004</td>
<td>5</td>
<td>5</td>
<td>5</td>
<td>100</td>
<td>20</td>
<td>30</td>
<td>30</td>
</tr>
</tbody>
</table>

### Example 3: Tolerance Days

- Item6
  - Procurement Method: Buy
  - Lead Time: 5 Days
  - Tolerance Days: 3 Days
- MRP Planning Horizon: July 7 - July 16
- Current Date: July 7
- Sales Order: July 13, Quantity 100
- Purchase Order: July 16, Quantity 100

In this case, the MRP run returns no recommendations. There is a demand on July 13; however, as defined, you are willing to tolerate 3 days (July 14, July 15, July 16). The demand can be fulfilled on July 16, hence no recommendations are scheduled. If the Tolerance Days value was fewer than 3 days, the recommendations order would be scheduled as displayed below.